This workbook is designed to go hand in hand with LearnKey online courseware. All material is copyrighted. It is illegal to duplicate this material without permission from the publisher.

To order additional copies contact:

LearnKey
35 North Main
St. George, UT 84770
1.435.674.9733
www.learnkey.com

Belongs to: ________________________________
School: ________________________________
Instructor: ______________________________
LearnKey, Division of LearnForce Partners, LLC provides self-paced training courses and online learning solutions to education, government, business, and individuals world-wide.

With dynamic video-based courseware and effective learning management systems, LearnKey solutions provide expert instruction for popular computer software, technical certifications, and application development. LearnKey delivers content on the Web, by enterprise network, and on interactive CD-ROM. For a complete list of courses visit:

http://www.learnkey.com

Trademarks: All brand names and product names used in this book are trade names, service marks, trademarks, or registered trademarks of their respective owners.

All rights reserved. No part of this book may be reproduced or transmitted in any form or by any means now known or to be invented, electronic or mechanical, including photocopying, recording, or by any information storage or retrieval system without written permission from the author or publisher, except for the brief inclusion of quotations in a review.

© 2011 LearnKey, Division of LearnForce Partners, LLC www.learnkey.com

202167

Licensed for Educational Purposes Only
# Table of Contents

## Introduction

- Using this Workbook: vii
- Course Maps: ix
- Course Outlines: xiii
- Skills Assessment: xvi
- Shortcut Keys: xviii

## Session 1

- Time Tables: 27
- Fill-in-the-Blanks: 28
- Crossword: 31
- Word Search: 33
- Short Answer: 34
- Matching: 37
- Research Topics: 38
- Individual Projects: 39
- Group Projects: 41
- Quiz: 43
- Slides & Notes: 47

## Session 2

- Time Tables: 53
- Fill-in-the-Blanks: 54
- Crossword: 57
- Word Search: 59
- Short Answer: 60
- Matching: 63
- Research Topics: 65
- Individual Projects: 66
- Group Projects: 67
- Quiz: 68
- Slides & Notes: 72

## Session 3

- Time Tables: 77
- Fill-in-the-Blanks: 78
- Crossword: 81
- Word Search: 83
- Short Answer: 84
- Matching: 87
- Research Topic: 88
- Individual Project: 89
- Group Project: 90
- Quiz: 82
- Slides & Notes: 96

---

Licensed for Educational Purposes Only
Introduction
Using this Workbook

In the Introduction section, you will find an outline for each session of training and sample lesson plans. These are included to give you an overview of the training content and to help you structure your lessons. The content, delivered by industry professionals, is the most up-to-date, comprehensive content available.

The exercises included in this workbook are meant to serve as supplementary material for the OnlineExpert courses. The following types of exercises are included for each session of training:

* **Fill-in-the-Blanks:** The student completes a comprehensive fill-in-the-blank exercise while watching each session of the training. Each exercise follows the instructor’s lecture and can be used as a review for the Quiz, the Pre-Assessments, and the Post-Tests.

* **Glossary Crossword and Word Search Puzzles:** These puzzles, taken directly from the courses’ glossary, are intended to help your students become more familiar with the terms found in each session.

* **Short Answer:** The short answer questions facilitate recall of the basic training concepts to further aid in retention of the course topics and information in preparation for the training’s Pre-Assessments and Post-Tests.

* **Matching:** The matching exercise provides additional learning reinforcement of terms and concepts found throughout the training in the courses’ glossary.

* **Research Topic:** The research topic gives your students the opportunity to research an applicable real-world situation whose answer will require using their understanding of the training as well as outside resources to generate a response.

* **Projects:** The individual and group projects require your students to apply the knowledge gained during the training to complete the assigned task. By using both individual and group projects, students receive the added benefit of applying the knowledge they have gained in a situation that mimics life in the workforce.

* **Quiz:** The quizzes will help you gauge your students’ progress. They also provide your students additional preparation for the training Pre-Assessment and Post-Tests.
These workbook exercises, used in conjunction with the LearnKey training, give your students the best learning experience possible.

**Shoot File Links:** The links to shoot files contain any of the actual files (Excel spreadsheets, Flash FLA files, etc.) that are used and demonstrated during the training. The files will typically have a starting file containing all data necessary to begin the demonstrated skill, as well as a completed file that shows the final result.

**Keyboard Shortcuts & Tips:** The keyboard shortcuts and tips provide a reference of product-specific keyboard shortcuts and helpful hints to make working more efficient.

**Objective Mapping:** The objective mapping provides a quick reference as to where in the training a specific certification exam objective is covered.

**Best Practices Guide:** The best practices guide gives you, as the instructor, the help you will need to effectively incorporate the workbook and training into your classroom experience. This guide comes from teachers like yourself and has been proven time and time again.

**Running & Training Time Table:** The running and training time tables will help you to better plan your lessons based on the time you have available. The running time is the actual time required to simply watch the training. The training time is an estimated average time that it will take to watch and discuss the concepts presented as well as do any applicable exercises.

**Skills Assessment:** The skills assessment will help you and your students to gauge their understanding of course topics prior to beginning any coursework. Understanding where your students, as a group, feel less confident will aid you in planning and getting the most from the training.
Word 2010 Course Map

Session 1

Introduction

Exploring the New Layout
Understanding Backstage View
Understanding Application Layout
Insert Tab
Page Layout Tab
References Tab
Mailings Tab
Review Tab
View Tab
Hiding the Ribbon
Status Bar
Version Comparison

Navigating Documents

Show/Hide Paragraph Marks
Using CTRL+END/HOME
Word-by-Word Navigation
Paragraph Navigation
Page Navigation
Selecting Text
Views Defined
Print Layout/Full Screen Reading Views
Customizing View Options
Web Layout and Outline Views
Contextual Tabs
Working in Outline View
Draft View
Customizing the Status Bar

Using Backstage

Document Information
Document Permissions
Manage Versions
Recent, New, and Print Options
Save & Send Options
Change File Type on Save
Compatibility Check
Using Help
ALT Keyboard Shortcuts
File Management
File Sorting

Managing Document Design

Using Built-In Themes
Customizing Themes
Saving Themes
Using Quick Parts
Creating and Inserting AutoText
Document Property
Field Quick Parts
Building Blocks Organizer

1.0 Working with Microsoft Word 2010

1.1 Apply different views to a document

1.2 Apply protection to a document

1.3 Demonstrate how to use the Manage Versions tool Backstage

1.4 Demonstrate how to Share documents by using Backstage

1.5 Apply saving by using the Save/Save As dialogs in Backstage

3.0 Page Layout and Quick Parts

5.2 Apply themes to a Microsoft Word 2010 document

3.3 Construct content in a Microsoft Word 2010 document by using the Quick Parts tool
Preparing Documents for Printing

- Spelling and Grammar Checking
- Adding Words to Dictionary
- Proofing Options
- AutoCorrect Options
- Using the Thesaurus
- Readability Statistics
- Using Find
- Replacing Text
- Find Options
- Creating Comments
- Navigating Comments

Printing

- Print Preview in Backstage
- Print Options
- Help Options
- Office.com Help

2.0 Text and Paragraph Formatting
- 2.2 Demonstrate how to use Find features

5.0 Proofing
- 5.1 Demonstrate the use of various spelling and grammar checking options in Microsoft Word 2010
- 5.2 Demonstrate how to modify AutoCorrect settings
- 5.3 Demonstrate how to use comments in a Microsoft Word 2010 document
## Session 2

### Working with Templates
- Built-in Templates
- New from Template
- Creating a Template
- Office.com Templates

1.0 Working with Microsoft Word
1.6 Demonstrate knowledge of working with templates

### Formatting Text
- Font Formatting Shortcuts
- Mini Formatting Toolbar
- Set Font Defaults
- Format Text Effects
- Working with Text Effects
- Formatting Tools

2.0 Text and Paragraph Formatting
2.1 Apply font attributes

### Formatting Paragraphs
- Paragraph Formatting Shortcuts
- Paragraph and Page Defaults
- Indentation
- First Line Indents
- Tab Stop Types
- Creating Tab Stops
- Dot Leader
- Justification
- Reset Paragraph Formatting

2.0 Text and Paragraph Formatting
2.3 Apply indentation and tab settings to paragraphs
2.4 Apply spacing settings to text paragraphs

### Organizing Data
- Tables Defined
- Creating Tables
- Drawing Tables
- Inserting Quick Tables
- Nested Tables
- Adjusting Table Layout
- Converting Text to Tables
- Adjusting Table Alignment
- Inserting Formulas in Tables

2.0 Text and Paragraph Formatting
2.5 Demonstrate how to insert tables
2.6 Manipulate tables in a Microsoft Word 2010 document

### Bulleted and Numbered Lists
- Using Bulleted Lists
- Using Numbered Lists
- Multilevel Lists

2.0 Text and Paragraph Formatting
2.7 Demonstrate how to work with bullets in a Microsoft Word 2010 document

### Manipulating Page Layout
- Using Sections
- Inserting a Cover Page
- Inserting a Blank Page
- Inserting Breaks
- Column Breaks
- Inserting Column Breaks
- Column Width
- Page Size

3.0 Page Layout and Quick Parts
3.1 Apply and manipulate page setup settings in a Microsoft Word 2010 document

### Manipulating Page Backgrounds
- Page Color
- Page Borders
- Watermarks
- Customized Watermark
- Manipulating Background Colors

3.0 Page Layout and Quick Parts
3.4 Create and manipulate page backgrounds in a Microsoft Word 2010 document

### Headers and Footers
- Inserting and Removing Headers
- Inserting Footers
- Navigating Headers and Footers
- Header and Footer Options

3.0 Page Layout and Quick Parts
3.5 Demonstrate how to work with headers and footers
Session 3
Working with Visual Content

- Inserting Pictures
- Formatting Pictures
- Cropping Images
- Inserting Clip Art
- Image Text Wrapping
- Adjust Wrapping
- Working with Quick Styles

- Inserting Shapes
- Shape Styles
- Shadow Effects
- 3-D Effects
- Adding Text to Shapes
- Inserting SmartArt
- Customizing SmartArt
- SmartArt Tools
- Inserting Charts
- Chart Quick Layout
- Inserting Screenshots
- Inserting Text Boxes
- Customizing Text Boxes
- Selection Pane
- Saving Text Boxes

Shapes, SmartArt, and Charts

Customizing Document Styles

- Applying Styles
- Creating and Saving Styles
- Table of Contents
- Hyperlinks
- Links within a Document
- E-mail Link

Citing References

- Adding Captions
- Table of Figures
- Inserting Footnotes
- Bibliography Style
- Inserting a Bibliography
- Creating an Index
- Table of Authorities

Mail Merge

- Mail Merge Process
- Step by Step Wizard
- Add or Filter Recipients
- Writing Your Letter
- Completing the Merge

Document Collaboration

- Track Changes
- Send for Review
- Compare Documents
- Document Protection
- AutoSave Options
- Managing Versions

4.0 Illustrations and Graphics

- 4.1 Demonstrate knowledge of working with Pictures in a Microsoft Word 2010 document
- 4.3 Demonstrate a knowledge of working with Clip Art

- 4.2 Demonstrate knowledge of working with Shapes
- 4.4 Apply and manipulate text boxes

6.0 References and Hyperlinks

- 6.1 Applying a hyperlink to text in a Microsoft Word 2010 document
- 6.3 Demonstrate knowledge of Table of Contents in a Microsoft Word 2010 document

- 6.2 Create Endnotes and Footnotes in a Microsoft Word 2010 Document

7.0 Mail Merge

- 7.1 Perform a mail merge operations
- 7.2 Demonstrate how to Print and Print Preview a mail merge

1.0 Working with Microsoft Word 2010

- 1.2 Apply protection to a document
- 1.3 Demonstrate how to use the Manage Versions tool Backstage
- 1.4 Demonstrate how to Share documents by using Backstage
- 1.5 Apply saving by using the Save/Save As dialogs in Backstage
Word 2010 Outlines

Session 1

Introduction
Exploring the New Layout
Understanding Backstage View
Understanding Application Layout
Insert Tab
Page Layout Tab
References Tab
Mailings Tab
Review Tab
View Tab
Hiding the Ribbon
Status Bar
Version Comparison

Navigating Documents
Show/Hide Paragraph Marks
Using CTRL+END/HOME
Word-by-Word Navigation
Paragraph Navigation
Page Navigation
Selecting Text
Views Defined
Print Layout/Full Screen Reading Views
Customizing View Options
Web Layout and Outline Views
Contextual Tabs
Working in Outline View
Draft View
Customizing the Status Bar

Using Backstage
Document Information
Document Permissions
Manage Versions
Recent, New, and Print Options
Save & Send Options
Change File Type on Save
Compatibility Check

Using Help
ALT Keyboard Shortcuts
File Management
File Sorting

Managing Document Design
Using Built-In Themes
Customizing Themes
Saving Themes
Using Quick Parts
Creating and Inserting AutoText
Document Property
Field Quick Parts
Building Blocks Organizer

Preparing Documents for Printing
Spelling and Grammar Checking
Adding Words to Dictionary
Using the Thesaurus
Proofing Options
AutoCorrect Options
Using AutoCorrect
Readability Statistics
Using Find
Replacing Text
Find Options
Creating Comments
Navigating Comments

Printing
Print Preview in Backstage
Print Options
Help Options
Office.com Help
Session 2

Working with Templates
   - Built-in Templates
   - New from Template
   - Creating a Template
   - Office.com Templates

Formatting Text
   - Font Formatting Shortcuts
   - Mini Formatting Toolbar
   - Set Font Defaults
   - Format Text Effects
   - Working with Text Effects
   - Formatting Tools
   - Using Format Painter

Formatting Paragraphs
   - Paragraph Formatting Shortcuts
   - Paragraph and Page Defaults
   - Indentation
   - First Line Indents
   - Tab Stop Types
   - Creating Tab Stops
   - Dot Leader
   - Justification
   - Reset Paragraph Formatting

Organizing Data
   - Tables Defined
   - Creating Tables
   - Drawing Tables
   - Inserting Quick Tables
   - Nested Tables
   - Adjusting Table Layout
   - Converting Text to Tables
   - Adjusting Table Alignment
   - Inserting Formulas in Tables

Bulleted and Numbered Lists
   - Using Bulleted Lists
   - Using Numbered Lists

Multilevel Lists

Manipulating Page Layout
   - Using Sections
   - Inserting a Cover Page
   - Inserting a Blank Page
   - Inserting Breaks
   - Column Breaks
   - Inserting Column Breaks
   - Column Width
   - Page Size

Manipulating Page Backgrounds
   - Page Color
   - Page Borders
   - Watermarks
   - Customized Watermark
   - Manipulating Background Colors

Headers and Footers
   - Inserting and Removing Headers
   - Inserting Footers
   - Navigating Headers and Footers
   - Header and Footer Options
Session 3

Working with Visual Content
- Inserting Pictures
- Formatting Pictures
- Cropping Images
- Inserting Clip Art
- Image Text Wrapping
- Adjust Wrapping
- Working with Quick Styles

Shapes, SmartArt, and Charts
- Inserting Shapes
- Shape Styles
- Shadow Effects
- 3-D Effects
- Adding Text to Shapes
- Inserting SmartArt
- Customizing SmartArt
- SmartArt Tools
- Inserting Charts
- Chart Quick Layout
- Inserting Screenshots
- Inserting Text Boxes
- Customizing Text Boxes
- Selection Pane
- Saving Text Boxes

Customizing Document Styles
- Applying Styles
- Creating and Saving Styles
- Table of Contents
- Hyperlinks
- Links within a Document
- E-mail Links

Citing References
- Adding Captions
- Table of Figures
- Inserting Footnotes
- Bibliography Style
- Inserting a Bibliography

Creating an Index
Table of Authorities

Mail Merge
- Mail Merge Process
- Step by Step Wizard
- Add or Filter Recipients
- Writing Your Letter
- Completing the Merge

Document Collaboration
- Track Changes
- Send for Review
- Compare Documents
- Document Protection
- AutoSave Options
- Managing Versions
# Skills Assessment

**Instructions:** Rate your skills with the following tasks on a level from 1-5.

<table>
<thead>
<tr>
<th>Skills</th>
<th>Poor</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Word 2010</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Displaying Formatting Marks</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Navigation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manipulating Documents in Outlining View</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Switching Windows</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adjusting the Status Bar</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Changing the File Type</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save a Theme</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add to Dictionary</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Basic Blank Templates</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Search Office.com</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shortcut Matching</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data Modification</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Centering a Table</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Insertion</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inserting a Column Break</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Implementing a Watermark</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Text within a Shape</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creating Building Blocks</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adding a Table of Contents</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Skills</td>
<td>Poor</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>------</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Insert Caption</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to Insert Footnotes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The Mail Merge Process</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accept Changes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Word 2010 Shortcuts Keys

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Keys</th>
<th>Command</th>
<th>Shortcut Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Caps</td>
<td>CTRL+SHIFT+A</td>
<td>Customize Keyboard</td>
<td>ALT+CTRL+NUM +</td>
</tr>
<tr>
<td>Annotation</td>
<td>ALT+CTRL+M</td>
<td>Customize Remove Menu</td>
<td>ALTCtrl+-</td>
</tr>
<tr>
<td>App Maximize</td>
<td>ALT+F10</td>
<td>Cut</td>
<td>CTRL+X or SHIFT+DELETE</td>
</tr>
<tr>
<td>App Restore</td>
<td>ALT+F5</td>
<td>Date Field</td>
<td>ALT+SHIFT+D</td>
</tr>
<tr>
<td>Apply Heading1</td>
<td>ALT+CTRL+1</td>
<td>Delete Back Word</td>
<td>CTRL+BACKSPACE</td>
</tr>
<tr>
<td>Apply Heading2</td>
<td>ALT+CTRL+2</td>
<td>Delete Word</td>
<td>CTRL+DELETE</td>
</tr>
<tr>
<td>Apply Heading3</td>
<td>ALT+CTRL+3</td>
<td>Dictionary</td>
<td>ALT+SHIFT+F7</td>
</tr>
<tr>
<td>Apply List Bullet</td>
<td>CTRL+SHIFT+L</td>
<td>Do Field Click</td>
<td>ALT+SHIFT+F9</td>
</tr>
<tr>
<td>Auto Format</td>
<td>ALT+CTRL+K</td>
<td>Doc Close</td>
<td>CTRL+W or CTRL+F4</td>
</tr>
<tr>
<td>Auto Text</td>
<td>F3 or ALT+CTRL+V</td>
<td>Doc Maximize</td>
<td>CTRL+F10</td>
</tr>
<tr>
<td>Bold</td>
<td>CTRL+B or CTRL+SHIFT+B</td>
<td>Doc Move</td>
<td>CTRL+F7</td>
</tr>
<tr>
<td>Bookmark</td>
<td>CTRL+SHIFT+F5</td>
<td>Doc Restore</td>
<td>CTRL+F5</td>
</tr>
<tr>
<td>Browse Next</td>
<td>CTRL+PAGE DOWN</td>
<td>Doc Size</td>
<td>CTRL+F8</td>
</tr>
<tr>
<td>Browse Previous</td>
<td>CTRL+PAGE UP</td>
<td>Doc Split</td>
<td>ALT+CTRL+S</td>
</tr>
<tr>
<td>Browse Sel</td>
<td>ALT+CTRL+HOME</td>
<td>Double Underline</td>
<td>CTRL+SHIFT+D</td>
</tr>
<tr>
<td>Cancel</td>
<td>ESC</td>
<td>End of Column</td>
<td>ALT+PAGE DOWN</td>
</tr>
<tr>
<td>Center Para</td>
<td>CTRL+E</td>
<td>End of Column</td>
<td>ALT+SHIFT+PAGE DOWN</td>
</tr>
<tr>
<td>Change Case</td>
<td>SHIFT+F3</td>
<td>End of Doc Extend</td>
<td>CTRL+SHIFT+END</td>
</tr>
<tr>
<td>Char Left</td>
<td>LEFT</td>
<td>End of Document</td>
<td>CTRL+END</td>
</tr>
<tr>
<td>Char Right</td>
<td>RIGHT</td>
<td>End of Line</td>
<td>END</td>
</tr>
<tr>
<td>Char Right Extend</td>
<td>SHIFT+RIGHT</td>
<td>End of Row</td>
<td>ALT+END</td>
</tr>
<tr>
<td>Clear</td>
<td>DELETE</td>
<td>End of Window</td>
<td>ALT+CTRL+PAGE DOWN</td>
</tr>
<tr>
<td>Close or Exit</td>
<td>ALT+SHIFT+C</td>
<td>Endnote Now</td>
<td>ALT+CTRL+D</td>
</tr>
<tr>
<td>Close Pane</td>
<td>CTRL+SHIFT+ENTER</td>
<td>Extend Selection</td>
<td>F8</td>
</tr>
<tr>
<td>Column Break</td>
<td>CTRL+SHIFT+F8</td>
<td>Field Chars</td>
<td>CTRL+F9</td>
</tr>
<tr>
<td>Column Select</td>
<td>CTRL+C or CTRL+INSERT</td>
<td>Field Codes</td>
<td>ALT+CTRL+F</td>
</tr>
<tr>
<td>Copy</td>
<td>CTRL+SHIFT+C</td>
<td>Find</td>
<td>CTRL+D or CTRL+SHIFT+F</td>
</tr>
<tr>
<td>Copy Format</td>
<td>SHIFT+F2</td>
<td>Font</td>
<td>CTRL+SHIFT+P</td>
</tr>
<tr>
<td>Copy Text</td>
<td>ALT+F3</td>
<td>Font Size Select</td>
<td>ALT+CTRL+F</td>
</tr>
<tr>
<td>Create Auto Text</td>
<td>ALT+CTRL+=</td>
<td>Footnote Now</td>
<td>SHIFT+F5 or ALT+CTRL+Z</td>
</tr>
<tr>
<td>Customize Add Menu</td>
<td></td>
<td>Go Back</td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Shortcut Keys</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Go To</td>
<td>CTRL+G or F5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grow Font</td>
<td>CTRL+SHIFT+T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grow Font One Point</td>
<td>CTRL+I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hanging Indent</td>
<td>ALT+SHIFT+R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Header Footer Link</td>
<td>F1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Help</td>
<td>CTRL+SHIFT+H</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hidden</td>
<td>CTRL+K</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hyperlink</td>
<td>CTRL+M</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indent</td>
<td>CTRL+1 or CTRL+SHIFT+I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Italic</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Justify Paragraph</td>
<td>CTRL+J</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Left Paragraph</td>
<td>CTRL+L</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line Down</td>
<td>DOWN</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line Down Extend</td>
<td>SHIFT+DOWN</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line Up</td>
<td>UP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line Up Extend</td>
<td>SHIFT+UP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>List Num Field</td>
<td>ALT+CTRL+L</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lock Fields</td>
<td>CTRL+3 or CTRL+F11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Macro</td>
<td>ALT+F8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mail Merge Check</td>
<td>ALT+SHIFT+K</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mail Merge Edit Data</td>
<td>ALT+SHIFT+E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Source</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mail Merge to Doc</td>
<td>ALT+SHIFT+N</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mail Merge to Printer</td>
<td>ALT+SHIFT+M</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mark Citation</td>
<td>ALT+SHIFT+I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mark Index Entry</td>
<td>ALT+SHIFT+X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mark Table of Contents Entry</td>
<td>ALT+SHIFT+O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Menu Mode</td>
<td>F10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Merge Field</td>
<td>ALT+SHIFT+F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Script Editor</td>
<td>ALT+SHIFT+F11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft System Info</td>
<td>ALT+CTRL+F1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move Text</td>
<td>F2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>New</td>
<td>CTRL+N</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Cell</td>
<td>TAB</td>
</tr>
<tr>
<td>Next Field</td>
<td>F11 or ALT+F1</td>
</tr>
<tr>
<td>Next Misspelling</td>
<td>ALT+F7</td>
</tr>
<tr>
<td>Next Object</td>
<td>ALT+DOWN</td>
</tr>
<tr>
<td>Next Window</td>
<td>CTRL+F6 or ALT+F6</td>
</tr>
<tr>
<td>Normal</td>
<td>ALT+CTRL+N</td>
</tr>
<tr>
<td>Normal Style</td>
<td>CTRL+SHIFT+N</td>
</tr>
<tr>
<td>Open</td>
<td>CTRL+O</td>
</tr>
<tr>
<td>Open or Close Up Para</td>
<td></td>
</tr>
<tr>
<td>Other Pane</td>
<td>F6 or SHIFT+F6</td>
</tr>
<tr>
<td>Outline</td>
<td>ALT+CTRL+O</td>
</tr>
<tr>
<td>Outline Collapse</td>
<td>ALT+SHIFT+-</td>
</tr>
<tr>
<td>Outline Demote</td>
<td>ALT+SHIFT+RIGHT</td>
</tr>
<tr>
<td>Outline Expand</td>
<td>ALT+SHIFT+=</td>
</tr>
<tr>
<td>Outline Move Down</td>
<td>ALT+SHIFT+DOWN</td>
</tr>
<tr>
<td>Outline Move Up</td>
<td>ALT+SHIFT+UP</td>
</tr>
<tr>
<td>Outline Promote</td>
<td>ALT+SHIFT+LEFT</td>
</tr>
<tr>
<td>Outline Show First Line</td>
<td>ALT+SHIFT+L</td>
</tr>
<tr>
<td>Overtype</td>
<td>INSERT</td>
</tr>
<tr>
<td>Page</td>
<td>ALT+CTRL+P</td>
</tr>
<tr>
<td>Page Break</td>
<td>CTRL+ENTER</td>
</tr>
<tr>
<td>Page Down</td>
<td>PAGE DOWN</td>
</tr>
<tr>
<td>Page Down Extend</td>
<td>SHIFT+PAGE DOWN</td>
</tr>
<tr>
<td>Page Field</td>
<td>ALT+SHIFT+P</td>
</tr>
<tr>
<td>Page Up</td>
<td>PAGE UP</td>
</tr>
<tr>
<td>Page Up Extend</td>
<td>SHIFT+PAGE UP</td>
</tr>
<tr>
<td>Para Down</td>
<td>CTRL+DOWN</td>
</tr>
<tr>
<td>Paragraph Down Extend</td>
<td>CTRL+SHIFT+DOWN</td>
</tr>
<tr>
<td>Paragraph Up</td>
<td>CTRL+UP</td>
</tr>
<tr>
<td>Paragraph Up Extend</td>
<td>CTRL+SHIFT+UP</td>
</tr>
<tr>
<td>Paste</td>
<td>CTRL+V or SHIFT+INSERT</td>
</tr>
<tr>
<td>Paste Format</td>
<td>CTRL+SHIFT+V</td>
</tr>
<tr>
<td>Prev Cell</td>
<td>SHIFT+TAB</td>
</tr>
<tr>
<td>Prev Field</td>
<td>SHIFT+F11 or ALT+SHIFT+F1</td>
</tr>
<tr>
<td>Command</td>
<td>Shortcut Keys</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Prev Object</td>
<td>ALT+UP</td>
</tr>
<tr>
<td>Prev Window</td>
<td>CTRL+SHIFT+F0 or ALT+SHIFT+F0</td>
</tr>
<tr>
<td>Print</td>
<td>CTRL+P or CTRL+SHIFT+F12</td>
</tr>
<tr>
<td>Print Preview</td>
<td>CTRL+F2 or ALT+CTRL+I</td>
</tr>
<tr>
<td>Proofing</td>
<td>F7</td>
</tr>
<tr>
<td>Redo</td>
<td>ALT+SHIFT+BACKSPACE</td>
</tr>
<tr>
<td>Redo or Repeat</td>
<td>CTRL+Y or F4 or ALT+ENTER</td>
</tr>
<tr>
<td>Repeat Find</td>
<td>SHIFT+F4 or ALT+CTRL+Y</td>
</tr>
<tr>
<td>Replace</td>
<td>CTRL+H</td>
</tr>
<tr>
<td>Reset Char</td>
<td>CTRL+SPACE or CTRL+SHIFT+Z</td>
</tr>
<tr>
<td>Reset Para</td>
<td>CTRL+Q</td>
</tr>
<tr>
<td>Revision Marks Toggle</td>
<td>CTRL+SHIFT+EQUAL</td>
</tr>
<tr>
<td>Right Para</td>
<td>CTRL+R</td>
</tr>
<tr>
<td>Save</td>
<td>CTRL+S or SHIFT+F12</td>
</tr>
<tr>
<td>Save As</td>
<td>F12</td>
</tr>
<tr>
<td>Select All</td>
<td>CTRL+A or CTRL+CLEAR (NUM 5)</td>
</tr>
<tr>
<td>Select Table</td>
<td>ALT+CLEAR (NUM 5)</td>
</tr>
<tr>
<td>Show All</td>
<td>CTRL+SHIFT+8</td>
</tr>
<tr>
<td>Show All Headings</td>
<td>ALT+SHIFT+A</td>
</tr>
<tr>
<td>Show Heading1</td>
<td>ALT+SHIFT+1</td>
</tr>
<tr>
<td>Show Heading2</td>
<td>ALT+SHIFT+2</td>
</tr>
<tr>
<td>Show Heading3</td>
<td>ALT+SHIFT+3</td>
</tr>
<tr>
<td>Show Heading4</td>
<td>ALT+SHIFT+4</td>
</tr>
<tr>
<td>Show Heading5</td>
<td>ALT+SHIFT+5</td>
</tr>
<tr>
<td>Show Heading6</td>
<td>ALT+SHIFT+6</td>
</tr>
<tr>
<td>Show Heading7</td>
<td>ALT+SHIFT+7</td>
</tr>
<tr>
<td>Show Heading8</td>
<td>ALT+SHIFT+8</td>
</tr>
<tr>
<td>Show Heading9</td>
<td>ALT+SHIFT+9</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Shortcut Keys</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Update Fields</td>
<td>F9 or ALT+SHIFT+U</td>
</tr>
<tr>
<td>Update Source</td>
<td>CTRL+SHIFT+F7</td>
</tr>
<tr>
<td>VBCode</td>
<td>ALT+F11</td>
</tr>
<tr>
<td>Web Go Back</td>
<td>ALT+LEFT</td>
</tr>
<tr>
<td>Web Go Forward</td>
<td>ALT+RIGHT</td>
</tr>
<tr>
<td>Word Left</td>
<td>CTRL+LEFT</td>
</tr>
<tr>
<td>Word Left Extend</td>
<td>CTRL+SHIFT+LEFT</td>
</tr>
<tr>
<td>Word Right</td>
<td>CTRL+RIGHT</td>
</tr>
<tr>
<td>Word Right Extend</td>
<td>CTRL+SHIFT+RIGHT</td>
</tr>
<tr>
<td>Word Underline</td>
<td>CTRL+SHIFT+W</td>
</tr>
</tbody>
</table>
# Session 1 Time Tables

<table>
<thead>
<tr>
<th>Session 1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Introduction</strong></td>
<td>0:23:47</td>
</tr>
<tr>
<td><strong>Navigating Documents</strong></td>
<td>0:32:50</td>
</tr>
<tr>
<td><strong>Using Backstage</strong></td>
<td>0:20:02</td>
</tr>
<tr>
<td><strong>Managing Document Design</strong></td>
<td>0:18:07</td>
</tr>
<tr>
<td><strong>Preparing Documents for Printing</strong></td>
<td>0:26:18</td>
</tr>
<tr>
<td><strong>Printing</strong></td>
<td>0:06:26</td>
</tr>
<tr>
<td><strong>Training Time</strong></td>
<td>2:07:29</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Session 1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Introduction</strong></td>
<td>0:15:51</td>
</tr>
<tr>
<td><strong>Navigating Documents</strong></td>
<td>0:21:53</td>
</tr>
<tr>
<td><strong>Using Backstage</strong></td>
<td>0:13:21</td>
</tr>
<tr>
<td><strong>Managing Document Design</strong></td>
<td>0:12:05</td>
</tr>
<tr>
<td><strong>Preparing Documents for Printing</strong></td>
<td>0:17:32</td>
</tr>
<tr>
<td><strong>Printing</strong></td>
<td>0:04:17</td>
</tr>
<tr>
<td><strong>Actual Time</strong></td>
<td>1:24:59</td>
</tr>
</tbody>
</table>
Fill-in-the-Blanks

Instructions: While watching Session 1, fill in the missing words according to the information presented by the instructor.

References where answers are found are in brackets.

Introduction
1. The icons in Word 2010 are arranged in ___________ and ___________.
2. The ___________ key will take users back to the Home tab.
3. The Quick Parts function allows users to ___________ fields, and properties that are commonly used in a document.
4. A user can change the look of a document in a single ___________.
5. Compare, ___________, ___________, and Spelling & Grammar are functions which appear on the Review Ribbon tab.
6. Double-clicking any tab allows users to ___________ hide the Ribbon.

Navigating Documents
1. The CTRL+RIGHT ARROW shortcut can ___________ from one word to the next.
2. The shortcut ___________ allows a user to navigate through a document one paragraph at a time.
3. The shortcut CTRL+clicking in the sentence allows a user to ___________ a single sentence.
4. Draft, Outline, Web Layout, ___________, and Full Screen Reading are document view types.
5. ___________ and ___________ appear when using the Print Layout view.
6. The Show Page options, which are available in Word 2010, include: Show One Page, Show Two Pages, and ___________.
7. When a user performs a ___________, contextual tabs appear.
8. Pressing the ___________ key will allow a user to move to the next level in an outline.
9. ___________ and ___________ are not displayed in Draft View.
Using Backstage
1. Tags, Size, ____________, ____________, Words, ____________, and Total Editing Time is information displayed in the Properties section of Backstage.

2. Check for Issues, Manage Versions, and Protect Document are setting options and actions that can be performed in the ____________ area of a document.

3. Recent ____________ and Recent ____________ are two types of information displayed in the Recent menu of Backstage.


5. Using the Microsoft Word Compatibility Checker will ____________ on text which are unavailable in older versions of Microsoft Word.

6. The Help menu is based on a ____________ environment.

7. Files are organized alphabetically by default within the ____________ library.

Managing Document Design
1. The ____________ group is located on the Page Layout tab.

2. Theme fonts, ____________, Built-in themes, and ____________ are items located in the Themes group.

3. Building block is the type of item which is created when a text selection is ____________ as Auto Text.

4. Title, Author, ____________, Manager, and Company are examples of document properties.

5. Field, ____________, and Document Property are Quick Parts tools.

6. A ____________ cover page is an example of a building block.

Preparing Documents for Printing
1. The shortcut ____________ opens the thesaurus.

2. The AutoCorrect feature may be used to create ____________ shortcuts.

3. A user can locate the Find tool in the ____________ Home group.

4. A user can search for items, such as graphics or tables in the ____________ pane.

5. A user has the option to ____________ a document with or without comments being displayed.
Printing

1. Zoom, Live preview, Full page view, and View different pages are print preview options that are ______________ on the Print section of the Backstage View.

2. ______________, Margins, ______________, and Print Custom Range are print options available from the Print section of Backstage View.

3. The ______________ shortcut will allow a user to access Help.
Glossary Crossword

**Instructions:** Use the terms and clues below to complete the crossword puzzle.

a. document property  
b. contextual tabs  
c. word-by-word navigation  
d. document permissions  
e. status bar  
f. compatibility check  
g. view  
h. paragraph-by-paragraph navigation  
i. backstage view

[Crossword puzzle image]
Across

3. Lets users know which features are not available in the previous version of Word.

5. Using CTRL+RIGHT ARROW or CTRL+LEFT ARROW to allow users to jump from word to word within a document.

6. Item which adds information to a document which then travels with the document.

7. Using CTRL+UP ARROW or CTRL+DOWN ARROW to allow users to navigate from paragraph to paragraph within a document.

8. A full-screen user interface model that describes file-level functionality for the active document.

9. Displays the current page number, live word count, and different views that can be applied to a document.

Down

1. Uses access control lists to administer Read, Write, Execute, and Delete capabilities.


4. Tabs which automatically appear when a user is performing a specific task.
Glossary Word Search

Instructions: Use the clues below to complete the word search.

a. document property    e. status bar
b. contextual tabs    f. compatibility check
c. word-by-word navigation    g. view
d. document permissions    h. paragraph-by-paragraph navigation
i. backstage view
Short Answer

**Instructions:** Use the information learned while watching Session 1 to answer the questions.

1. List the two functions that are new to Word 2010.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

2. List the two places a user can change the view of a document.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

3. Name the actions that can be performed within the Outline view.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

4. Which features are available in the Save & Send menu?

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

5. Describe the process of using the Backstage function to apply the Show all formatting marks option.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

6. List examples of fields in Quick Parts.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
7. Name the items which are displayed in the Readability Statistics box.

8. Which preview options are displayed on the Print section of the Backstage view?

9. Describe the process of using the Status bar to navigate quickly from page two of six to page four, using a shortcut.

10. List all document view types.

11. Which Show Page options are available in Word 2010?

12. Describe the correct order of steps to move an item in Outline view.

13. Describe the correct order of steps to customize the Status bar.
14. What are the two types of information displayed in the Recent menu of the Backstage?

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

15. How would a user use the Backstage area to change the file extension to a Word 97-2003 document?

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
Glossary Matching

**Instructions:** Match the glossary term described in Session 1 to its definition.

a. document property  

b. contextual tabs  

c. word-by-word navigation  

d. document permissions  

e. status bar  

f. compatibility check  

g. view  

h. paragraph-by-paragraph navigation  

i. backstage view  

1. ___ Uses access control lists to administer Read, Write, Execute, and Delete capabilities.

2. ___ Lets users know which features are not available in the previous version of Word.

3. ___ Item which adds information to a document which then travels with the document.

4. ___ Using CTRL+UP ARROW or CTRL+DOWN ARROW to allow users to navigate from paragraph-to-paragraph within a document.

5. ___ Using CTRL+RIGHT ARROW or CTRL+LEFT ARROW to allow users to jump from word to word within a document.

6. ___ A full-screen user interface model that describes file-level functionality for the active document.

7. ___ Tabs which automatically appear when a user is performing a specific task.

8. ___ Displays the current page number, live word count, and different views that can be applied to a document.

Research Topics

Instructions: Research the topic below using the Internet and then write a few paragraphs reporting your findings. Be sure to research thoroughly and site the resources. This page may be used to take notes.

1. Research the differences in the new layout of Word 2010 versus previous versions of Word.

2. Research the different tabs on the new application bar of Word 2010. Write a report on the functions of each tab, and how a user may utilize each function. Pay close attention to the following tabs: Insert, Page Layout, References, Mailings, Review, and View.

3. Write a report on how these shortcuts help a user utilize Word 2010 in a more efficient manner.
Individual Projects

Instructions: Assign each student the following project. Each student should prepare a short 5-10 minute class presentation of the information researched.

1. There have been several changes made to the layout of the new Word 2010. It is important for a user to understand how to utilize these changes in order to have a successful experience working with Word 2010.

For this individual project, create a presentation which compares the layout changes in Word 2010 to that of previous versions. This presentation should include, but is not limited to:

- Tabs
- Ribbon
- Status bar
- Backstage view
- Application layout

2. Word 2010 has provided several shortcuts and speedkeys for users to utilize while creating a document. These shortcuts and speedkeys save a user valuable time.

For this individual project, create a demonstration that will be presented to the class. This demonstration should show how the shortcuts discussed in session 1 of Word 2010 make using Word 2010 more efficient when performing these actions:

- Print options
- Managing documents
- Navigating documents
- Utilizing the new layout

3. Word 2010 has revamped the options for printing a document.

For this individual project, the student will create a presentation based on the new print options found in Word 2010. Choose from the list of options presented in Session 1 of Word 2010 for preparing documents for printing, and then demonstrate how to print a document using the new printing options. Options to cover include, but are not limited to:

- Proofing
- AutoCorrect
- Help Options
- Print Options
- Print Preview
Office.com Help
Spell/grammar check
Group Projects

**Instructions:** Divide into groups and assign each group one of the following subjects to research. Each group should prepare a short 5-10 minute class presentation of the information researched.

1. The Backstage is a new feature found in Word 2010. It is important that a user understand how the Backstage feature functions and how to utilize it to increase the users success in using Word 2010.

   For this group project, the group will create a visual presentation that demonstrates the user-friendliness of the Backstage feature. The group may want to divide into sections to cover the material more thoroughly; however, the presentation should be cohesive. Topics to include, but are not limited to:
   - Help
   - Versions
   - Shortcuts
   - File options
   - Save & Send
   - Print options
   - Document information/permissions

2. Using design elements in a Word program in the past has sometimes been challenging. In fact, other Microsoft programs were favored for using design elements over Word because they were more user-friendly. However, this is not the case anymore. Word 2010 has new options for managing design elements within a Word document.

   For this group project, the group will be constructing a document that incorporates and highlights the new design elements found in Word 2010. This document will be turned in to the instructor. The group will also create a presentation for the class. The document to be turned in to the instructor and the presentation should correlate. The group may be subdivided into smaller groups to cover the material. Topics to consider include, but are not limited to:
   - Saving
   - AutoText
   - Quick Parts
   - Customizing
   - Building Block
   - Built-In Themes

3. It is not only important to learn about the new features, layouts, and tools found within Word 2010, but how to successfully apply them.
For this group project, the group will create a document that highlights elements learned in session 1 of Word 2010. This document should answer the following questions, by explanation in text and/or visual demonstration in the document:

1. What is new?
2. How does this save a user time?
3. How does this compare to previous versions of Word?
4. Why was this important to highlight?

Next, the group will create a presentation that demonstrates their new Word 2010 to the class. The document will be turned into the instructor for a grade.

Elements from Word 2010 to consider, but not be limited to:
- Tabs
- Views
- Layout
- Ribbon
- Printing
- Backstage
- Navigation
- Web layout
- Print layout
- Customization
- Document design
Session 1 Quiz

Instructions: Circle the letter of the option that BEST answers the question.

1. What is the default view for Word 2010?
   a. Split
   b. Zoom
   c. Full Screen
   d. Print Layout

2. What is the function of the CTRL+END shortcut?
   a. Takes user to the end of a line
   b. Takes user to the end of a page
   c. Creates a new blank document
   d. Takes user to the end of a document

3. The HOME key will take the user to which location in a document?
   a. The File dialog box
   b. The Paragraph dialog box
   c. Beginning of the document
   d. Beginning of the current line

4. Which action will display the Customize Status Bar menu?
   a. Right-click the status bar
   b. Status bar is unchangeable
   c. Click Advanced on the File tab
   d. Click the Customize menu on the Home tab

5. Users may control how often a document is autosaved.
   a. True
   b. False

6. Pressing which key will display keyboard shortcuts?
   a. TAB
   b. ALT
   c. CTRL
   d. SHIFT
7. From which location can a user view Document Property information?
   a. Layout view
   b. Settings page
   c. Backstage view
   d. Options dialog box

8. Which type of error displays a red, wavy line beneath the word?
   a. Homonym
   b. Spelling error
   c. Grammatical error
   d. Sentence fragment

9. What is the function of the F1 key?
   a. Access Help
   b. Select all text
   c. Save document
   d. Run spell check

10. Which items are located on the Review tab? Choose all that apply.
    a. Compare
    b. Comments
    c. Track Changes
    d. Spelling and Grammar

11. What is the result of double-clicking a tab?
    a. Opens contextual tabs
    b. A new document is opened
    c. Temporarily hides the Ribbon
    d. Opens the Customize Ribbon dialog box

12. What is the result of using the CTRL+UP ARROW shortcut?
    a. Opens the Formatting dialog box
    b. Navigate through the Ribbon tabs
    c. Navigate through a document one page at a time
    d. Navigate through a document one paragraph at a time

13. Which are document view types? Choose all that apply.
    a. Draft
    b. Outline
    c. Web Layout
    d. Full Screen Reading

    a. True
    b. False
15. Which options appear in Draft view? Choose all that apply.
   a. Footers
   b. Headers
   c. Hard return
   d. Paragraph breaks

16. Which information may be found in the Backstage area? Choose all that apply.
   a. Title
   b. Size
   c. Words
   d. Comments
   e. Total Editing Time

17. From which location can the Check for Issues and Protect Document functions be found?
   a. The View tab
   b. Backstage area
   c. The Quick Access menu
   d. The Document Format dialog box

18. Which options are available when sending a document using e-mail in the Save & Send menu? Choose all that apply.
   a. Save to SharePoint
   b. Send as PDF
   c. Publish as Blog Post
   d. Send Using E-mail

19. By default, documents in Word 2010 are saved in PDF format.
   a. True
   b. False

20. The Help menu is based on which type of environment?
   a. Web
   b. Video
   c. VLOOKUP
   d. Reference book

21. Which are examples of Quick Parts tools? Choose all that apply.
   a. Field
   b. Styles
   c. AutoText
   d. Document Property
22. Which is an example of a building block?
   a. Font
   b. Images
   c. Built-in cover page
   d. Headers and Footers

23. What is the function of the SHIFT+F7 shortcut?
   a. Opens the Thesaurus
   b. Opens the Web browser
   c. Turns Format Painter on
   d. Spell checks the document

24. On which tab is the Editing group found?
   a. View
   b. Home
   c. Review
   d. References

   a. True
   b. False
Notes:

_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
Session 2
## Session 2 Time Tables

<table>
<thead>
<tr>
<th>Session 2</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with Templates</td>
<td>0:17:28</td>
</tr>
<tr>
<td>Formatting Text</td>
<td>0:24:06</td>
</tr>
<tr>
<td>Formatting Paragraphs</td>
<td>0:30:06</td>
</tr>
<tr>
<td>Organizing Data</td>
<td>0:27:24</td>
</tr>
<tr>
<td>Bulleted and Numbered Lists</td>
<td>0:07:23</td>
</tr>
<tr>
<td>Manipulating Page Layout</td>
<td>0:18:06</td>
</tr>
<tr>
<td>Manipulating Page Backgrounds</td>
<td>0:11:18</td>
</tr>
<tr>
<td>Headers and Footers</td>
<td>0:08:46</td>
</tr>
</tbody>
</table>

**Training Time** 2:24:37

<table>
<thead>
<tr>
<th>Session 2</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with Templates</td>
<td>0:11:39</td>
</tr>
<tr>
<td>Formatting Text</td>
<td>0:16:04</td>
</tr>
<tr>
<td>Formatting Paragraphs</td>
<td>0:20:04</td>
</tr>
<tr>
<td>Organizing Data</td>
<td>0:18:16</td>
</tr>
<tr>
<td>Bulleted and Numbered Lists</td>
<td>0:04:55</td>
</tr>
<tr>
<td>Manipulating Page Layout</td>
<td>0:12:04</td>
</tr>
<tr>
<td>Manipulating Page Backgrounds</td>
<td>0:07:32</td>
</tr>
<tr>
<td>Headers and Footers</td>
<td>0:05:51</td>
</tr>
</tbody>
</table>

**Actual Time** 1:36:25
Fill-in-the-Blanks

**Instructions:** While watching Session 2, fill in the missing words according to the information presented by the instructor.

[References where answers are found are in brackets.]

**Working with Templates**

1. The New from Existing option would be selected if a user wanted to create a template based on formatting options of ____________.
2. A user can save a document as a template in the ____________ field.
3. Agendas, Brochures, ____________, and ____________ are examples of Office.com templates.

**Formatting Text**

1. The keyboard shortcut __________________________ will result in word underline.
2. When formatting groups of text, a user should ____________ desired text first.
3. The ____________ action reveals the mini formatting toolbar.
4. The options that may be configured in Format Text Effects include: Glow and Soft Edges, ____________, ____________, Text Outline, and Outline Style.
5. The ____________ allows a user to view different text formatting styles before applying the effect.
6. The Format Painter feature allows a user to ____________ text formatting to other areas of the document.

** Formatting Paragraphs**

1. From the Show Group on the View Tab Location, a user can turn on or off the ____________.
2. The First Line Indent is represented by an ____________ triangle on the ruler.
3. On the Home tab and the ____________ tab, a user may view and configure indentation, spacing, and other paragraph options.
4. When a user uses a ____________, numbers are displayed with whole numbers on the left of the tab stop, and decimals to the right of the tab stop.
Organizing Data
1. A user can create a table in the Insert Table __________ and The Insert Table grid with live preview.
2. The draw table tool may be used to create a __________ table.
3. Quick Tables can be inserted by clicking the __________ in the Insert Tab.
4. __________ tabs appear when a feature is needed.
5. Pressing the TAB key and placing the cursor in the very last cell in combination will allow users to add a/an __________ line to a table.

Bulleted and Numbered Lists
1. Users can pick and choose the __________ of bullet that appears on a document by utilizing the Home tab.
2. Word 2010 allows users to __________ new number formats.

Manipulating Page Layout
1. The steps needed to implement sections into a Word document include: click Section and __________ on the Status bar.
2. Blank Pages appear in the Pages drop-down menu on the __________ Ribbon tab.
3. __________ Page, __________ Page, and Page Break are types of pages that appear in the Pages drop-down menu on the Insert Ribbon tab.
4. Users can perform Odd Page, Even Page, __________, and Continuous section breaks.
5. A section break must be inserted in order to __________ orientations within one document.
6. Adjusting the __________ simultaneously adjusts the column width.
7. __________ pages can be accommodated for documents in Word.

Manipulating Page Backgrounds
1. __________, __________, Texture, and Gradient are fill effects which are available for a Word 2010 document.
2. When implementing a border on a document, users can choose the Style, __________, __________, and Width.
3. A watermark is a __________ or graphic behind a document.
4. Text and __________ are types of watermarks a user can use to implement into a document.
Headers and Footers

1. A user can use the Insert Ribbon tab to insert a header into a ____________.

2. The ____________ button allows a user to link to the previous section so the header and footer in the current section contain the same content as the previous section.

3. 0.5 inches is the ____________ position of the footer in Word 2010.

4. A simple way to enter a header or footer is to ____________ in the header or footer.
Glossary Crossword

Instructions: Use the terms and clues below to complete the crossword puzzle.

a. mini formatting toolbar  g. format painter  m. columns
b. cover page  h. nested tables  n. alignment
c. TAB stop  i. footer  o. hanging indent
d. text effects  j. templates  p. dot leader
e. tables  k. cell  q. bulleted list
f. justification  l. watermark  r. header

[Crossword puzzle image]
Across

5. A group of information organized into a table which is contained within a larger table.

7. A small contextual toolbar which appears when text is selected in a document.

10. A row of dots which connect two items on a page, commonly used in a table of contents.

11. A tool used in Microsoft Word which allows the user to copy formatting items, such as font, to other areas of the document.

12. An image which appears lighter than the text on the printed page in order to identify the document.

14. The first page of a document which may include general introductory information, such as title, date, author, or address.

17. A format style which places a small amount of text extending out in the left margin, while the main body is indented.

18. A formatting style which allows the user to organize text into multiple vertical blocks.

Down

1. A group of predefined formatting styles which may be customized and applied to text.

2. The position of text or graphics in relation to the margins of a document.

3. The act of aligning text so the words are evenly spaced, filling up the entire width of the page or column.

4. A set of predefined rules and styles that may be used as a base to create many different types of documents including, but not limited to: resumes, flyers, newsletters, and blog posts.

6. A customizable location on the horizontal ruler of a document where the cursor appears when the TAB key is pressed.

8. A method of organizing information into a list where each line is separated by a small icon called a bullet.

9. The top margin of a page in a document where items, such as title, page number, or other identifying information, may be placed.

13. The bottom margin of a page in a document where items, such as page number, footnotes, or other identifying information, may be placed.

15. A visual method of organizing information into rows and columns.

16. A text area created by the intersecting sections of columns and rows in a table.
Glossary Word Search

Instructions: Use the clues below to complete the word search.

a. mini formatting toolbar  
g. format painter  
m. columns
b. cover page  
h. nested tables  
n. alignment
c. TAB stop  
i. footer  
o. hanging indent
d. text effects  
j. templates  
p. dot leader
e. tables  
k. cell  
q. bulleted list
f. justification  
l. watermark  
r. header
Short Answer

Instructions: Use the information learned while watching Session 2 to answer the questions.

1. List some examples of predefined templates.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

2. Name the keyboard shortcut combination that opens the Font dialog box.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

3. What items may be configured in the Paragraph dialog box?

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

4. List some types of tabs.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

5. Define Dot Leader.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

6. What is the shortcut CTRL+Q used for?

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
7. List the two page orientations available in Word 2010.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

8. List the fill effects categories which are available for a Word document.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

9. What does the Link to Previous button allow a user to do?

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

10. Describe the process for creating a blank document template.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

11. List examples of Office.com templates.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

12. Name the locations from which a user can create a table.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

13. Describe how a user would convert highlighted text to a table, assuming all defaults are accepted.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
14. List, in correct order, the steps to center a table.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

15. Describe, in the correct order, the steps to insert a blank page within an existing page.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
# Glossary Matching

**Instructions:** Match the glossary term described in Session 2 to its definition.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. mini formatting toolbar</td>
<td>A small contextual toolbar which appears when text is selected in a document.</td>
</tr>
<tr>
<td>b. cover page</td>
<td>The first page of a document which may include general introductory information, such as title, date, author, or address.</td>
</tr>
<tr>
<td>c. TAB stop</td>
<td>A small contextual toolbar which appears when text is selected in a document.</td>
</tr>
<tr>
<td>d. text effects</td>
<td>A visual method of organizing information into rows and columns.</td>
</tr>
<tr>
<td>e. tables</td>
<td>A group of information organized into a list where each line is separated by a small icon called a bullet.</td>
</tr>
<tr>
<td>f. justification</td>
<td>A formatting style which allows the user to organize text into multiple vertical blocks.</td>
</tr>
<tr>
<td>g. format painter</td>
<td>A text area created by the intersecting sections of columns and rows in a table.</td>
</tr>
<tr>
<td>h. nested tables</td>
<td>A group of information organized into a table which is contained within a larger table.</td>
</tr>
<tr>
<td>i. footer</td>
<td>A small contextual toolbar which appears when text is selected in a document.</td>
</tr>
<tr>
<td>j. templates</td>
<td>A heading style which places a small amount of text extending out in the left margin, while the main body is indented.</td>
</tr>
<tr>
<td>k. cell</td>
<td>A set of predefined rules and styles that may be used as a base to create many different types of documents.</td>
</tr>
<tr>
<td>l. watermark</td>
<td>A group of predefined formatting styles which may be customized and applied to text.</td>
</tr>
<tr>
<td>m. columns</td>
<td>An image which appears lighter than the text on the printed page in order to identify the document.</td>
</tr>
<tr>
<td>n. alignment</td>
<td>The position of text or graphics in relation to the margins of a document.</td>
</tr>
<tr>
<td>o. hanging indent</td>
<td>The act of aligning text so the words are evenly spaced, filling up the entire width of the page or column.</td>
</tr>
<tr>
<td>p. dot leader</td>
<td>A row of dots which connect two items on a page, commonly used in a table of contents.</td>
</tr>
<tr>
<td>q. bulleted list</td>
<td>A tool used in Microsoft Word which allows the user to copy formatting items, such as font, to other areas of the document.</td>
</tr>
</tbody>
</table>
LearnKey

16. ___ A customizable location on the horizontal ruler of a document where the cursor appears when the TAB key is pressed.

17. ___ The top margin of a page in a document where items, such as title, page number, or other identifying information may be placed.

18. ___ The bottom margin of a page in a document where items, such as page number, footnotes, or other identifying information may be placed.
Research Topics

Instructions: Research the topic below using the Internet and then write a few paragraphs reporting your findings. Be sure to research thoroughly and cite the resources. This page may be used to take notes.

1. Research the different methods in Word 2010 for manipulating page backgrounds. Write a report on how a user may utilize these methods to enhance a Word 2010 document. Pay attention to Color, Borders, and Watermarks.


3. Research the Word 2010 options for Bulleted and Numbered lists. Write a report on the different types of lists, including Bulleted, Numbered, and Multilevel, and how they are utilized in a Word 2010 document.
Individually Projects

Instructions: Assign each student the following project. Each student should prepare a short 5-10 minute class presentation of the information researched.

1. Word 2010 provides a user with various shortcuts for formatting the font of a document. These shortcuts save a user time and increasing efficiency.

   For this individual project, the student will research and memorize the various font formatting shortcuts, their purpose, and how to efficiently and effectively apply them to a Word 2010 document. The student will then create a visual demonstration on how user-friendly these shortcuts are, and how efficiently they save time when used within their correct purpose.

2. A great feature included in the new Word 2010 program is the Text Effects button located under the Home tab. This feature provides some versatile options for a user when formatting the text of a Word document.

   For this individual project, the student will become familiar with the Text Effects feature in Word 2010. The student will either use an existing document, or create a new document, and then apply each option found in the Text Effects feature. The student will document each feature, and its effect on text in a document. This documentation will be compiled into a written report to be turned into the instructor.

   A visual demonstration and report may also be assigned and presented to the class.

3. Key points in a document should really stand out. Word 2010 gives a user some great options for doing this by using bulleted and/or numbered lists.

   For this individual project, the student will create a Word 2010 document which demonstrates and illustrates the different uses of bulleted lists and numbered lists, as well as multilevel lists in a document. This document will be turned into the instructor along with a written report on the students findings. A visual demonstration will also be presented to the class.
Group Projects

**Instructions:** Divide into groups and assign each group one of the following subjects to research. Each group should prepare a short 5-10 minute class presentation on the information researched.

1. Knowing how to organize data in a Word 2010 document is essential for a user to have a successful result.

For this group project, the group will be subdivided into three categories:
1. Tables and Formulas: inserting formulas in tables
2. Formatting Tables: nested, layout, and alignment
3. Introduction to Tables: defining, creating, drawing, and inserting

A group presentation will be created demonstrating the different elements for organizing data. Each group should document their findings, which will be combined into a written report to be turned into the instructor.

2. A great feature provided to a user in Word 2010 is the ability to manipulate page backgrounds. For this group project, the group will create a Word 2010 document. The group will use the document to display the different options for manipulating page backgrounds and create a presentation for the class. For the presentation, the group will focus on the following elements:
   - Page color
   - Watermarks
   - Page borders
   - Background colors

3. Understanding the elements of formatting text, paragraphs, data, and layout is not as important as being able to successfully apply them to a given Word 2010 document.

For this group project, the group will create an original document highlighting elements from the following categories:
   - Formatting text
   - Formatting paragraphs
   - Formatting/organizing data
   - Formatting/manipulating layout

The group may wish to divide and conquer. However, a concise presentation and report should be created and presented to the class and the instructor.
Session 2 Quiz

Instructions: Circle the letter of the option that BEST answers the question.

1. Which new Word 2010 feature can add a shadow, a glow, or a reflection to selected text?
   a. WordArt
   b. Emphasis
   c. Text Effects
   d. Text Painter

2. Which items may be configured in the Paragraph dialog box? Choose all that apply.
   a. Font
   b. Spacing
   c. Indentation
   d. Line spacing

3. Which keyboard shortcut is used to reset formatting?
   a. CTRL+V
   b. CTRL+X
   c. CTRL+Z
   d. CTRL+Q

4. Users can pick and choose the style of bullet that appears on a document by utilizing which Ribbon tab?
   a. View
   b. Insert
   c. Home
   d. Page Layout

5. Landscape and _________ are two page orientations available in Word 2010.
   a. Simple
   b. Portrait
   c. Distorted
   d. Extended

6. Which Fill Effects categories are available for a Word document? Choose all that apply.
   a. Picture
   b. Pattern
   c. Texture
   d. Gradient
7. Using which Ribbon tab can a user insert a header into a document?
   a. View
   b. Insert
   c. Review
   d. Page Layout

8. Which button allows a user to link to the previous section so the header and footer in the current section contain the same content as the previous section?
   a. Link Back
   b. Link to Past
   c. Link to Anterior
   d. Link to Previous

9. Which action reveals the mini formatting toolbar?
   a. Right-click
   b. Double-click
   c. Click while holding down CTRL
   d. Click while holding down SHIFT

10. The live preview allows a user to view different text formatting styles before applying the effect.
    a. True
    b. False

11. From which location can a user turn on or off the ruler display?
    a. The Show group on the View tab
    b. The Guidelines group on the View tab
    c. The Rulers group on the Page Layout tab
    d. The Display group on the Page Layout tab

12. How can a user-inserted tab stop be removed from the ruler?
    a. Double-click the tab
    b. Click and drag the tab off the ruler
    c. Select No Tabs from the mini toolbar
    d. Select Remove Tab from the Paragraph group

13. From which locations can a user create a table? Choose all that apply.
    a. The View tab
    b. The right-click menu
    c. The Insert Table dialog box
    d. The Insert Table grid with live preview

    a. Blank Page
    b. Cover Page
    c. Page Break
    d. Reference Page
15. Users can perform which types of section breaks? Choose all that apply.
   a. Odd Page
   b. Even Page
   c. Next Page
   d. Continuous

16. Odd-sized pages can be accommodated for documents in Word.
   a. True
   b. False

17. What is a watermark?
   a. A new document
   b. A used document
   c. A wet spot on a printed document
   d. Ghosted text or a graphic behind a document

18. Which choices are available in the Options group of the Header and Footer Tools Design Ribbon tab? Choose all that apply.
   a. Date and Time
   b. Different First Page
   c. Show Document Text
   d. Different Odd & Even Pages

19. Which is the default position of the footer in Word 2010?
   a. 0.5 inch
   b. 0.6 inch
   c. 0.10 inch
   d. 0.15 inch

20. Adjusting the __________ simultaneously adjusts the column width.
   a. ruler
   b. themes
   c. references
   d. orientation

21. Which option must be inserted in order to mix orientations within one document?
   a. Margin
   b. Dialog box
   c. Section break
   d. Comment option

22. Which are steps needed to implement sections into a Word document? Choose all that apply.
   a. Click Section
   b. Click the Home tab
   c. Right-click on the Status bar
   d. Click the Page Layout Ribbon tab
23. When do context-sensitive tabs appear?
   a. When a feature is needed
   b. When a drop-down menu is opened
   c. When a user clicks the Context button
   d. When the Context check box is selected

24. Which tool may be used to create a custom table?
   a. Draw table
   b. Table brush
   c. Table painter
   d. Cell formatter

25. Which Microsoft application would be helpful for performing complex calculations in a table?
   a. Excel
   b. Access
   c. Publisher
   d. PowerPoint
Session 3
# Session 3 Time Tables

<table>
<thead>
<tr>
<th>Session 3</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with Visual Content</td>
<td>0:13:54</td>
</tr>
<tr>
<td>Shapes, SmartArt, and Charts</td>
<td>0:33:44</td>
</tr>
<tr>
<td>Customizing Document Styles</td>
<td>0:20:01</td>
</tr>
<tr>
<td>Citing References</td>
<td>0:19:36</td>
</tr>
<tr>
<td>Mail Merge</td>
<td>0:17:57</td>
</tr>
<tr>
<td>Document Collaboration</td>
<td>0:18:04</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Training Time</strong></td>
<td>02:55:14</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Session 3</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with Visual Content</td>
<td>0:09:16</td>
</tr>
<tr>
<td>Shapes, SmartArt, and Charts</td>
<td>0:22:29</td>
</tr>
<tr>
<td>Customizing Document Styles</td>
<td>0:13:34</td>
</tr>
<tr>
<td>Citing References</td>
<td>0:13:04</td>
</tr>
<tr>
<td>Mail Merge</td>
<td>0:11:58</td>
</tr>
<tr>
<td>Document Collaboration</td>
<td>0:12:03</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Actual Time</strong></td>
<td>01:56:49</td>
</tr>
</tbody>
</table>
Fill-in-the-Blanks

Instructions: While watching Session 3, fill in the missing words according to the information presented by the instructor.

[References where answers are found are in brackets.]

Working with Visual Content

1. Clip art, bitmaps, ___________ files, and ___________ files are image types which can be incorporated into a Word document.

2. Users can use the ___________ contextual tab to make adjustments to colors, corrections, and artistic effects.

3. To maintain proportion while resizing a picture perform, the user only needs to hold down the ___________ key.

4. Cropping allows users to ___________ parts of a picture.

5. Users are able to search in clip art for the following types of media: audio, ___________, ___________, and photographs.

6. The Wrap Text tool allows users to place text in a document as ___________ to an image as possible.

7. The Position tool allows users to ___________ the layout options that work best for a particular document.

Shapes, SmartArt, and Charts

1. Shapes can be ___________ into a document from the Illustrations group.

2. The Shadow Effects function is located under the ___________ Ribbon tab.

3. The SmartArt tool is located under the ___________ Ribbon tab.

4. The SmartArt graphics types available in Word 2010 include: all, list, ___________, picture, process, ___________, and relationship.

5. Users can make ___________ directly from Word 2010.

6. The Quick Layout tool allows users to ___________ the entire layout of a chart.

7. The Insert ___________ text boxes action is performed by the Text Box tool.
8. The ______________________ allows a user to stretch a text box.
9. The Selection Pane helps users when there are problems ______________ an item in a document.
10. Users can draw text boxes as well as select from ______________ ones.

**Customizing Document Styles**
1. The ______________ shortcut may be used to insert a page break.
2. The table of contents does not update automatically whenever pages are ______________ or ______________.

**Citing References**
1. The ______________ button in the Footnotes group allows a user to view footnotes and endnotes in a document.
2. Book, report, ______________, and an article in a periodical are examples of sources that may be used when creating a citation.
3. The ______________ button allows a user to select words from a document to be used in an index.
4. A user can find tools to ______________ citations in a document under the Table of Authorities References group.

**Mail Merge**
1. The following options are available in the ______________ step of the Mail Merge process: Type a new list, Use an existing list, and Select from Outlook contacts.
2. The following groups are located on the ______________ tab: Finish, Create, Preview Results, Start Mail Merge, and Write & Insert Fields.
3. Examples of fields contained in the Mail Merge Recipients dialog box include: Title, ______________, ______________, and E-mail address.
4. A user can filter a list by ______________ items from various fields.
5. A user can select to insert just the first name of the letter recipient in the ______________ location.
6. Once the Mail Merge process has been completed, individual pages may be ______________.

**Document Collaboration**
1. Document changes and comments are displayed in the ______________ Pane.
2. The following options are available on the ______________ tab: Final, Original, Final: Show
3. A user can send a copy of a document to another person from the ___________ area.

4. The ___________ feature allows a user to view the number of revisions, insertions, deletions, and other editing items.

5. A user can customize save options in the ___________ location.

6. Examples of options that may be configured in the Save section of Word options include: ___________, Save AutoRecover frequency, and Keep the last autosaved version if I close without saving.

7. Manage Versions allows a user to ___________ unsaved documents.

8. A user can manage versions under the ___________ section of the BackStage area.
Glossary Crossword

Instructions: Use the terms and clues below to complete the crossword puzzle.

a. Selection panel  d. SmartArt  g. styles  j. document protection
b. chart  e. mail merge  h. table of contents  k. bibliography
c. hyperlink  f. wrap text  i. shape styles
Across
7. The process of combining a data source and a main document.
8. A page within a document which lists various sections of the document along with its corresponding page number.
9. A graphic representation of data from a table which may be displayed in various formats, such as a bar, line, or pie charts.
10. A group on the Format Ribbon tab where users may change the fill color, border, and shape of an image.
11. A link in a document used to navigate from one document to a new document or a new section within the current document.

Down
1. A set of tools which allows a user to secure a document from alteration by other users by setting permissions, passwords, and other security features.
2. A tool used to help select individual objects and to change their order in visibility.
3. A page within a document which lists the sources and research used in the text.
4. To configure the object so that it moves along with the text around it.
5. A collection of customizable visual diagrams, including list, process, hierarchy, and cycle.
6. Predefined formatting options which may be applied to various aspects of the document, including, but not limited to: tables, charts, layouts, and text.
Glossary Word Search

Instructions: Use the clues below to complete the word search.

a. Selection panel  d. SmartArt  g. styles  j. document protection
b. chart  e. mail merge  h. table of contents  k. bibliography
c. hyperlink  f. wrap text  i. shape styles

Q S J A L V X C N M Z Q C A G P Z E P M P T X V
E O A Z J H F I W H A Y N Q H B Z A X E Z H W J J
J W Y H Z J S J T Z G I X X T R Q V Y M H F B N A
H X T K L D N G T W S Q L Y F E T S M F V E K G K
K V K E O P R A J Q P N M E Y G U N L L Y N H R
Y O N K Z E P K J D A S H E D R T F E L Y S K D W
O I G C F K E F P R M R W M T T G K E E G T O T A
A G Z U U K Q V G X H D Y C Q N T E K N D M S Q H
N O I T C E T O R P T N E M U C O D S A J T K I Y
K B A I B K I Q A D G T C G S G C F P E R F I P
S S W S L L Z Y F C S T B T H P G F N X A W E E
N F W I Q J P K M X I P R Z F W S U S I E C X C L
C U B C R J A L S H L A R P X D K F V T B L O I I
F D E H G O M Y R J P E Y X H T C U W C P D B L N
S P P O C V E L U T S Y C D Z H T L R E S E K A K
J C A D Q D M B E Z C G K P Q L O Z D L G E B T
L B I B G N M X Y O B C Z F T Z T U T E C A K C S
O W R K O B T X S X N B R Z O N Y O C S L W A G N
D V Z C O H U N Z H D P Q U P Q P T R A T R A M S
B Q H P L L A A K C S E O Z J V H H G V H C H K T
L N F G Q Z U N Z X P W R S V L V A Q B C E U Z A
K P E W M P A G U N Y L N W M N N H G A S W B H H
Short Answer

Instructions: Use the information learned while watching Session 3 to answer the questions.

1. Name the types of images found in Word 2010.

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

2. List the Wrap Text function options.

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

3. Name the three formats users can change text to when utilizing the Styles group under the Home tab.

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

4. What is the function of the Change Styles button?

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

5. Which items are included in a table of figures by default?

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________


___________________________________________________________________

___________________________________________________________________

___________________________________________________________________
7. What is the function of the Mark Entry button?

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

8. List the groups located on the Mailings tab.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

9. List the Show Markup option which are available on the Review tab.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

10. Name some examples of options that may be configured in the Save section of Word options.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

11. List, in the correct order, the steps to insert text into a shape or picture.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

12. Name the SmartArt graphic types which are available in Word 2010.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

13. What is the function of the Quick Layout tool?

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
14. What is Screen Clipping?

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

15. List the steps a user would take to insert a table of contents into a document, using the Automatic Table 2 style.

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________
Glossary Matching

**Instructions:** Match the glossary term described in Session 3 to its definition.

1. **A set of tools which allows a user to secure a document from alteration by other users by setting permissions, passwords, and other security features.**

2. **A page within a document which lists the sources and research used in the text.**

3. **A page within a document which lists various sections of the document along with its corresponding page number.**

4. **Predefined formatting options which may be applied to various aspects of the document, including, but not limited to: tables, charts, layouts, and text.**

5. **A graphic representation of data from a table which may be displayed in various formats, such as a bar, line, or pie.**

6. **A collection of customizable visual diagrams including, list, process, hierarchy, and cycle. Various styles, colors, and other formatting attributes may be applied.**

7. **To configure the object so that it moves along with the text around it.**

8. **A tool used to help select individual objects and to change their order in visibility.**

9. **A tool which adds 3-D effects to shapes.**

10. **A group on the Format Ribbon tab where users may change the fill color, border, and shape of an image.**

11. **A link in a document used to navigate from one document to a new document or a new section within the current document.**

12. **The process of combining a data source and a main document.**
Research Topics

**Instructions:** Research the topic below using the Internet and then write a few paragraphs reporting your findings. Be sure to research thoroughly and cite the resources. This page may be used to take notes.

1. Research the different visual elements that can be incorporated into a Word 2010 document. Write a report on how these visual elements are utilized and how they enhance a document. Pay attention to Pictures, Clip Art, Text Wrapping, and Quick Styles.


3. Research the Word 2010 mail merge options. Write a report on how mail merge enhances a letter a user may be composing. Include in the report the initial mail merge process, the step-by-step wizard, add or filter recipients, writing the letter, and completing the merge.
Individual Projects

**Instructions:** Assign each student the following project. Each student should prepare a short 5-10 minute class presentation of the information researched.

1. Word 2010 is equipped with options for inserting and formatting images, as well as Quick Styles. Many of these features may not be familiar to a Word 2010 user.

   For this individual project, the student will become familiar with inserting and applying visual content to a document. A presentation will be created demonstrating how this is done and how user-friendly it is.

   Things to include in the presentation:
   - Clip art
   - Quick Styles
   - Cropping Images
   - Image Text Wrapping
   - Inserting/Formatting Pictures

2. Word 2010 has provided the user with options for customizing document styles.

   For this individual project, create a document which demonstrates and highlights the options for customizing document styles. Be sure to document the process, and incorporate that documentation into a written report to be turned in with the document. This presentation should include, but is not limited to:
   - Hyperlinks
   - E-mail links
   - Applying, creating, and saving styles

   The report and document will be turned into the instructor.

3. SmartArt is a great feature that is provided to users in Word 2010. Unfortunately, knowing about SmartArt, and knowing how to utilize SmartArt are two different things.

   For this individual project, the student will become familiar with using SmartArt to enhance a Word 2010 document. A presentation will be created where the student instructs the class on the properties of SmartArt and how to utilize SmartArt in a Word 2010 document. The student should include visual demonstrations to demonstrate SmartArt in use.
Group Projects

**Instructions:** Divide into groups and assign each group one of the following subjects to research. Each group should prepare a short 5-10 minute class presentation on the information researched.

1. Word 2010 has provided users with several different options for inserting and customizing shapes, styles, art, charts, and text. Understanding how to utilize these different options is important for the average user.

For this group project, the group will select five different options from the Shapes, SmartArt, and Charts Instruction in session 3 of the Word 2010 instructional video to highlight. The group may choose to dive itself into five different categories to better cover the material. A presentation will be created in which the group demonstrates the five selected options.

Options to consider, but are not limited to:
- Charts
- Shapes
- Shadow
- SmartArt
- 3-D effects
- Text boxes

2. Creating and formatting letters, reports, and other full-body documents are among some of the most common uses of a Word Program. Word 2010 gives the user many options for creating and formatting these documents.

For this group project, the group will create a visual presentation which demonstrates different options for letters, reports, etc. This presentation should include, but is not limited to:
- Index
- Captions
- Footnotes
- Mail merge
- Bibliography
- Step-by-step wizard

3. When collaborating with other users on a single document, it is important to be able to track changes, compare different elements, protect changes, save, and manage different versions. Luckily, Word 2010 provides the users with these options.
For this group project, the group will collaborate on an original document. The group will track changes, send for a review, compare documents, provide document protection, utilize AutoSave options, and manage the different versions of the document. Each step should be documented. The group will then present their document to the class in a presentation that visually demonstrates each element.

The documentation should be compiled into a report to be turned into the instructor, along with a copy of the collaborated document.
Session 3 Quiz

Instructions: Circle the letter of the option that BEST answers the question.

1. Which are examples of image types? Choose all that apply.
   a. Clip art
   b. TIFF files
   c. Bitmaps
   d. JPEG files

2. What is the primary benefit of using clip art?
   a. Photographic quality
   b. Extensive editing capabilities
   c. The ability to search for images
   d. User-created shapes and drawings

3. Which are examples of Wrap Text options? Choose all that apply.
   a. Tight
   b. Square
   c. Behind Text
   d. Top and Bottom

4. On which tab is the Illustrations group located?
   a. Insert
   b. Home
   c. Shapes
   d. Reference

5. Which group is located on the References tab?
   a. Paragraph
   b. Header & Footer
   c. Table of Contents
   d. Page Background

6. What is the function of CTRL+click?
   a. Spell checks the document
   b. Selects all text in the document
   c. Allows a user to follow a hyperlink
   d. Applies conditional formatting to the text
7. By default, which items are included in a table of figures? Choose all that apply.
   a. Page numbers
   b. List of figures
   c. Appropriate text
   d. Chapter headings

8. MLA is an example of which Word 2010 document element?
   a. Bibliography style
   b. Text format
   c. Column organization style
   d. Page layout

9. Which Compare Documents feature allows a user to view the number of revisions, insertions, deletions, and other editing items?
   a. Editor
   b. Report
   c. Summary
   d. List Modifications

10. Which feature is located in the Info section of the Backstage area?
    a. Themes
    b. Page background
    c. Manage versions
    d. Table of Contents

11. Which is an example of an adjustment that can be made from within the Picture Tools contextual tab?
    a. Fonts
    b. Header
    c. Corrections
    d. Picture review

12. Which key may be held down while resizing a picture in order to maintain proportion?
    a. ALT
    b. CTRL
    c. SHIFT
    d. Left arrow

13. Which tool allows users to remove parts of an image?
    a. Slice
    b. Crop
    c. Paste
    d. Resize
14. Which arrangement option allows users to place text in a document as close to an image as possible?
   a. Wrap text
   b. Place text
   c. Insert text
   d. Adjust text

15. Which tool allows users to choose the layout options that work best for a particular document?
   a. Crop
   b. Color
   c. Position
   d. Corrections

16. Which is an example of a tool located on the Format contextual Ribbon tab?
   a. Columns
   b. Orientation
   c. Shadow Effects
   d. Page Borders

17. Which SmartArt graphic types are available in Word 2010? Choose all that apply.
   a. List
   b. Cycle
   c. Process
   d. Hierarchy

18. Charts must be imported from an external source and cannot be created directly in Word 2010.
   a. True
   b. False

19. What is the function of the Quick Layout tool?
   a. Changes the entire layout of a chart
   b. Converts the chart to a numerical table
   c. Allows users to view various print templates
   d. Applies a color scheme to a text-only document

20. Which item helps users when there are problems selecting an item?
   a. Clipboard
   b. Page Selector
   c. Selection Pane
   d. Paragraph Selection Tool
21. What is the function of the CTRL+ENTER shortcut?
   a. Insert table
   b. Insert footnote
   c. Insert page break
   d. Open Font dialog box

22. What is the function of the Show Notes button in the Footnotes group?
   a. Displays hidden notes and comments
   b. Removes print restrictions from footnotes
   c. Highlights the numbers used to designate a footnote
   d. Allows a user to view footnotes and endnotes in a document

23. Which are examples of sources that may be used when creating a citation? Choose all that apply.
   a. Book
   b. Report
   c. Journal Article
   d. Article in a Periodical

24. A user can send a copy of a document to another person from the Backstage area.
   a. True
   b. False

25. Which Word 2010 feature allows users to recover unsaved documents?
   a. Building Blocks
   b. Backup Manager
   c. Manage Versions
   d. Document History
Slides & Notes

Notes:

______________________________
______________________________
______________________________
______________________________
______________________________

Notes:

______________________________
______________________________
______________________________
______________________________
______________________________

Notes:

______________________________
______________________________
______________________________
______________________________
______________________________

Notes:

______________________________
______________________________
______________________________
______________________________
______________________________
Notes:

__________________________________________________________________
__________________________________________________________________
__________________________________________________________________
__________________________________________________________________
__________________________________________________________________
__________________________________________________________________
__________________________________________________________________
__________________________________________________________________
Education without Boundaries

Thank you for using LearnKey education tools. Our education solutions are designed to help students, teachers, administrators, and staff become proficient in the use of critical software and technology.

Our blended learning solutions use Internet technologies to deliver:

- Video-based online courseware
- Project-based lab work, assignments, and simulations
- Proven study plans, student workbooks, and teacher guides
- Automated reporting of activity and results

To order additional copies contact:

LearnKey
35 North Main
St. George, UT 84770
1.435.674.9733
www.learnkey.com

Licensed for Educational Purposes Only